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AGENDA:
1. Review current FHIR resources and management process
0. Validation and DSTU comments
0. Profiles – development and availability
0. What project scope statements are required for this work?
1. New FHIR resources
1. Review of topics and new project scope statement(s)
0. Referral
0. Care transfer
1. Process for approval and tracking
1. Agenda for next meeting (March 27, April 3)

Current Patient Care FHIR Resources:  http://www.hl7.org/implement/standards/FHIR-Develop/?ref=learnmore

The FHIR issue tracker in gForge: 
http://gforge.hl7.org/gf/project/fhir/tracker/?action=TrackerItemBrowse&tracker_id=677

All resource proposals
http://wiki.hl7.org/index.php?title=Category:FHIR_Resource_Proposal

Referral skeleton
http://wiki.hl7.org/index.php?title=Referral_FHIR_Resource_Proposal


Current Clinical FHIR Resources
1. Adverse Reaction
1. Allergy Intolerance
1. Care Plan
1. Condition
1. Family History
1. Procedure
1. Questionnaire

David Hay walked the group through the elements of a resource at http://www.hl7.org/implement/standards/FHIR-Develop/?ref=learnmore

Using the resource “Condition” as an example the following constructs  of a FHIR resource were covered:
<Condition xmlns="http://hl7.org/fhir"> [image: doco]
 <!-- from Resource: extension, modifierExtension, language, text, and contained -->
 <identifier><!-- 0..* Identifier External Ids for this condition --></identifier>
 <subject><!-- 1..1 Resource(Patient) Who has the condition? --></subject>
 <encounter><!-- 0..1 Resource(Encounter) Encounter when condition first asserted --></encounter>
 <asserter><!-- 0..1 Resource(Practitioner|Patient) Person who asserts this condition --></asserter>
 <dateAsserted value="[date]"/><!-- 0..1 When first detected/suspected/entered -->
 <code><!-- 1..1 CodeableConcept Identification of the condition, problem or diagnosis --></code>
 <category><!-- 0..1 CodeableConcept E.g. complaint | symptom | finding | diagnosis --></category>
 <status value="[code]"/><!-- 1..1 provisional | working | confirmed | refuted -->


1. A 1..1 element such as “Subject” is required.
2. A 0..1 element such as “Encounter” is optional.
3. Resource (Patient) points to another resource
4. Status has coded options e.g. provisional, working, confirmed, refuted.  This is termed a “codeable concept”.

TO DO:  Patient Care should evaluate these codes.

[bookmark: 4.5.2.1]4.5.2.1 Terminology Bindings [image: http://www.hl7.org/implement/standards/FHIR-Develop/target.png]
	Path
	Definition
	Type
	Reference

	Condition.code
Condition.relatedItem.code 
	Identification of the Condition or diagnosis.
	Example
	http://hl7.org/fhir/vs/condition-code

	Condition.category 
	A category assigned to the condition. E.g. finding | Condition | diagnosis | concern | condition
	Incomplete
	http://hl7.org/fhir/vs/condition-category

	Condition.status 
	The clinical status of the Condition or diagnosis
	Fixed
	http://hl7.org/fhir/condition-status

	Condition.certainty 
	The degree of confidence that this condition is correct
	Example
	http://hl7.org/fhir/vs/condition-certainty

	Condition.severity 
	A subjective assessment of the severity of the condition as evaluated by the clinician.
	Example
	http://hl7.org/fhir/vs/condition-severity

	Condition.relatedItem.type 
	The type of relationship between a condition and its related item
	Fixed
	http://hl7.org/fhir/condition-relationship-type



The group then reviewed terminology bindings – some are fixed, others incomplete, or examples.  A profile can select a preferred terminology binding.  The group questioned the impact of multiple terminology bindings and the impact on interoperability.  

A profile may also constrain or extend a resource or point to another profile.  The group then discussed the use of value sets such as a value set using SNOMED codes.  In that case a resource can include a tag that refers to the profile with the defined value set.

QUESTION to Lloyd – what if value sets are not aligned?

Are profiles registered anywhere? (e.g. for the use of specific value sets)?
This is a governance issue.

TO DO:  PC WG needs to review resource terminology bindings.

How to comment:
Use G Forge for posting and tracking comments related to PC WG resources.
Note that comments can also be posted at the bottom of each resource page – these can be monitored but are not used to effect changes.

TO DO: PC WG needs to decide how to manage resource comments posted on GForge.

Search Parameters:

[bookmark: 4.5.3]4.5.3 Search Parameters [image: http://www.hl7.org/implement/standards/FHIR-Develop/target.png]
Search parameters for this resource. The standard parameters also apply. See Searching for more information about searching in REST, messaging, and services.
	Name
	Type
	Description
	Paths

	_id
	token
	The logical resource id associated with the resource (must be supported by all servers)
	

	asserter
	reference
	Person who asserts this condition
	Condition.asserter
(Patient, Practitioner)

	category
	token
	The category of the condition
	Condition.category

	code
	token
	Code for the condition
	Condition.code


The group then reviewed search parameters.  A FHIR server must be able to deal with various search parameters.

TO DO:  PC WG needs to review resources search parameters.

Profiles:

There are different levels of profiles:
1. Profiles at the HL7 international level (for resources no found in the main resource list)
a. Realm specific profiles
i. Implementation specific profiles

A Work Group can create profiles using core resources.

Resource Maintenance:
1. PSS not needed for maintenance of current resources.  
2. Review elements of resources as noted based on subject matter expertise.
3. Use GForge for posting comments and for monitoring comment posted by others.
4. Write profiles as necessary to supplement core resources.
5. Note resources that may be shared between groups e.g. questionnaire…..

For New Resources:
1. Use a FHIR PSS:


[bookmark: _MON_1456847698]  
2. Provide resource descriptions (like storyboards)
3. Begin tooling – uses an excel spreadsheet

Requests of FMG:
1. Provide PC WG with FHIR tutorial slides so they can be posted on the wiki.


Next Call – Thursday, March 27 at 5 PM.

1. Review Agenda
2. David Hay will give a tutorial on FHIR Profiles
3. Review of Stephen Chu’s PSS for referrals
4. Plan agenda for next meeting – Thursday, April 3 at 5 PM.


[bookmark: _GoBack]
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		The objective of this document is to communicate the type of activities a group is undertaking to achieve specific objectives or to produce specific work products.   It’s intended for projects to produce standards or Implementation Guides as well as infrastructure projects.





Template Usage Information:


· Replace Highlighted Courier New text with appropriate content. 

· To use Track Changes, turn off “protection” by clicking on Tools > Unprotect Document  

· For assistance in completing each section, refer to Appendix A.

· Information on the Project Approval Process is documented in Appendix B.

· For FAQs (Frequently Asked Questions), refer to Appendix C

· Submit template change requests to PMO@HL7.org

1. Project Name and ID


		Click here to go to Appendix A for more information regarding this section.

		An ID will be assigned by Project Insight 



		Develop FHIR resources for Enter the name of your work group here.

		Project ID: 





2. Sponsoring Group(s) / Project Team

Click here to go to Appendix A for more information regarding this section.

		Primary Sponsor/Work Group (1 Mandatory) 

		Enter your Work Group name here.



		Co-sponsor Work Group(s)

		



		

		



		Project Team:

		



		Project facilitator (1 Mandatory)

		Enter Project Facilitator name here.



		Other interested parties and their roles

		



		Multi-disciplinary project team (recommended)

		



		     Modeling facilitator

		Enter a name here (or ask MnM for a name).



		     Publishing facilitator

		N/A



		     Vocabulary facilitator

		Enter a name here (or ask Vocab for a name)



		     Domain expert rep

		



		     Business requirement analyst

		



		     Other facilitators (SOA, SAIF)

		



		

		



		Implementers (2 Mandatory for DSTU projects):



		1)  



		2)  





Note: The implementer requirement will be handled by the “balloting” project.  Therefore work groups do not fill out the above section.  However, feel free to list implementers specific to your work group’s resources if you know of any.

3. Project Definition


3.a. Project Scope

Click here to go to Appendix A for more information regarding this section.

		This project will identify and define the initial set of “key” FHIR resources related to the domain of Your domain name.  These resources will be defined using the available FHIR tooling and in accordance with documented quality guidelines and balloted as part of the initial FHIR specification.  Expected FHIR resources to be produced include: List expected resource names (need not be all and need not be pre-approved).

In addition, as the committee deems appropriate and time availability permits, it will define a small number of FHIR extensions relevant to domain content and expected to be necessary to support consistent early implementations.





3.b. Project Need

		FHIR is a major new initiative by HL7 intended to significantly speed and enhance interoperability between healthcare systems.  The FHIR methodology is dependent on the existence of a number of discrete data structure definitions called “resources”.  This project will create the set of essential resource definitions related to the domain of Your domain name here.





3.c. Success Criteria

		Essential domain resources (as confirmed by the FHIR governance body) have been defined and successfully passed DSTU ballot.

Small set of FHIR extensions have been vetted and registered in HL7 FHIR extension repository.





3.d. Project Objectives / Deliverables / Target Dates

		Within each row, enter the explicit work product(s) / objective(s).  Indicate their target date at the right in WGM/Ballot Cycle format.  Include the project end date as the last objective (for standards projects, the end date will be the projected ANSI approval date).

Click here for further information and an EXAMPLE

		Target Date (in WGM or ballot cycle format, e.g.


‘2010 Sept WGM’ or 

‘2010 Jan Ballot’)



		Resource proposals have been submitted and endorsed for development by FHIR governance body

		July 15, 2012



		Resource content ready for inclusion in initial FHIR DSTU ballot

		Nov. 4, 2012



		Resources pass DSTU ballot

		Jan. 31, 2014



		

		



		

		





3.e. Project Dependencies

		The artifacts produced by this project will be balloted as part of the FHIR DSTU project (Project Insight ID TBD).





3.f. Project Document Repository Location 

		Resource content will be maintained in http://gforge.hl7.org/svn/fhir/trunk/source.  Additional project tracking and supporting project documents will be kept here:

Enter the SPECIFIC URL where supporting project documents, deliverables, ballot reconciliation work and other project information will be kept. A template to create a Project Page on the HL7 Wiki is available at: http://wiki.hl7.org/index.php?title=Template:Project_Page.





3.g. Backwards Compatibility

		Are the items being produced by this project backward compatible?


		 FORMCHECKBOX 
 Yes

		 FORMCHECKBOX 
 No

		 FORMCHECKBOX 
 Don’t Know

		 FORMCHECKBOX 
 N/A






		





		Mappings between existing static models and created resources may eventually be defined, but this work is out of scope for this project.





4. Products 


Click here to go to Appendix A for more information regarding this section


		 FORMCHECKBOX 


		Non Product Project- (Educ. Marketing, Elec. Services, etc.)






		

		 FORMCHECKBOX 


V3 Documents - Knowledge






		 FORMCHECKBOX 


Arden Syntax




		 FORMCHECKBOX 


V3 Foundation – RIM






		 FORMCHECKBOX 


Clinical Context Object Workgroup (CCOW)




		 FORMCHECKBOX 


V3 Foundation – Vocab Domains & Value Sets






		 FORMCHECKBOX 


Domain Analysis Model (DAM)




		 FORMCHECKBOX 


V3 Messages - Administrative






		 FORMCHECKBOX 


Electronic Health Record (EHR)




		 FORMCHECKBOX 


V3 Messages - Clinical






		 FORMCHECKBOX 


Functional Profile



		 FORMCHECKBOX 


V3 Messages - Departmental






		 FORMCHECKBOX 


V2 Messages – Administrative




		 FORMCHECKBOX 


V3 Messages - Infrastructure






		 FORMCHECKBOX 


V2 Messages - Clinical




		 FORMCHECKBOX 


V3 Rules - GELLO






		 FORMCHECKBOX 


V2 Messages - Departmental




		 FORMCHECKBOX 


V3 Services – Java Services (ITS Work Group)






		 FORMCHECKBOX 


V2 Messages – Infrastructure




		 FORMCHECKBOX 


V3 Services – Web Services






		 FORMCHECKBOX 


V3 Documents – Administrative (e.g. SPL)




		 FORMCHECKBOX 


- New Product Definition -






		 FORMCHECKBOX 


V3 Documents – Clinical (e.g. CDA)




		 FORMCHECKBOX 


- New/Modified HL7 Policy/Procedure/Process -






		 FORMCHECKBOX 


FHIR Resources



		 FORMCHECKBOX 


FHIR Extensions







5. Project Intent (check all that apply)


Click here to go to Appendix A for more information regarding this section


.

		 FORMCHECKBOX 


		Create new standard




		 FORMCHECKBOX 


		Revise current standard (see text box below)



		 FORMCHECKBOX 


		Reaffirmation of a standard




		 FORMCHECKBOX 


		New/Modified HL7 Policy/Procedure/Process



		 FORMCHECKBOX 


		N/A  (Project not directly related to an HL7 Standard)






		

		 FORMCHECKBOX 


Supplement to a current standard


 FORMCHECKBOX 


Implementation Guide (IG) will be created/modified


 FORMCHECKBOX 


Project is adopting/endorsing an externally developed IG

(specify external organization in Sec. 6 below)


 FORMCHECKBOX 


Externally developed IG is to be Adopted

 FORMCHECKBOX 


Externally developed IG is to be Endorsed







		Resources will be published as part of the first FHIR DSTU ballot





5.a. Ballot Type  (check all that apply)

		 FORMCHECKBOX 


		Comment Only




		 FORMCHECKBOX 


		Informative



		 FORMCHECKBOX 


		DSTU to Normative





		

		 FORMCHECKBOX 


Normative (no DSTU)

 FORMCHECKBOX 


Joint Ballot (with other SDOs or HL7 Work Groups)

 FORMCHECKBOX 


N/A  (project won’t go through ballot)








		This project will not ballot directly.  Instead, content will be combined with resources from other committees and jointly balloted as part of the FHIR DSTU ballot (managed as a distinct TSC project).





6. Project Approval Dates


Click here to go to Appendix A for more information regarding this section.

		Sponsoring Group Approval Date

		WG Approval Date CCYY-MM-DD



		Steering Division Approval Date  

		SD Approval Date CCYY-MM-DD





		PBS Metrics Reviewed? (required for SD Approval)


		 FORMCHECKBOX 
 Yes

		 FORMCHECKBOX 
 No





		





		FHIR Governance Committee Approval Date

		FG Approval Date CCYY-MM-DD



		Technical Steering Committee Approval Date

		TSC Approval Date CCYY-MM-DD





7. External Project Collaboration

Click here to go to Appendix A for more information regarding this section.

		In producing resources, the committee will consult specifications from a wide variety of external organizations, including OpenEHR, IHE, various affiliates, government organizations and other SDOs.  However, this consultation will not require direct interaction with these other organizations.  (Though some may be involved in the ballot review process.)


Feel free to note specific additional colaborations you intend to use in the development of your resources if applicable.





7.a. Stakeholders / Vendors / Providers 

This section must be completed for projects containing items expected to be ANSI approved, as it is an ANSI requirement for all ballots

		Stakeholders

		Vendors

		Providers



		 FORMCHECKBOX 
 Clinical and Public Health Laboratories

		 FORMCHECKBOX 
 Pharmaceutical

		 FORMCHECKBOX 
 Clinical and Public Health Laboratories



		 FORMCHECKBOX 
 Immunization Registries

		 FORMCHECKBOX 
 EHR, PHR

		 FORMCHECKBOX 
 Emergency Services



		 FORMCHECKBOX 
 Quality Reporting Agencies

		 FORMCHECKBOX 
 Equipment 

		 FORMCHECKBOX 
 Local and State Departments of Health



		 FORMCHECKBOX 
 Regulatory Agency

		 FORMCHECKBOX 
 Health Care IT

		 FORMCHECKBOX 
 Medical Imaging Service



		 FORMCHECKBOX 
 Standards Development Organizations (SDOs) 

		 FORMCHECKBOX 
 Clinical Decision Support Systems

		 FORMCHECKBOX 
 Healthcare Institutions (hospitals, long term care, home care, mental health)



		 FORMCHECKBOX 
 Payors 

		 FORMCHECKBOX 
 Lab

		 FORMCHECKBOX 
 Other (specify in text box below)



		 FORMCHECKBOX 
 Other (specify in text box below)

		 FORMCHECKBOX 
 HIS

		 FORMCHECKBOX 
 N/A



		 FORMCHECKBOX 
 N/A

		 FORMCHECKBOX 
 Other (specify below)

		



		

		 FORMCHECKBOX 
 N/A

		





		Other:  Indicate other stakeholders, vendors or providers not listed above.





		





7.b. Synchronization With Other SDOs / Profilers


Click here to go to Appendix A for more information regarding this section


		Check all SDO / Profilers which your project deliverable(s) are associated with.



		 FORMCHECKBOX 
 ASC X12

		 FORMCHECKBOX 
 CHA

		 FORMCHECKBOX 
 LOINC



		 FORMCHECKBOX 
 AHIP

		 FORMCHECKBOX 
 DICOM

		 FORMCHECKBOX 
 NCPDP



		 FORMCHECKBOX 
 ASTM

		 FORMCHECKBOX 
 GS1

		 FORMCHECKBOX 
 NAACCR



		 FORMCHECKBOX 
 BioPharma Association (SAFE)

		 FORMCHECKBOX 
 IEEE

		 FORMCHECKBOX 
 Object Management Group (OMG)



		 FORMCHECKBOX 
 CEN/TC 251

		 FORMCHECKBOX 
 IHE

		 FORMCHECKBOX 
 The Health Story Project



		 FORMCHECKBOX 
 CHCF

		 FORMCHECKBOX 
 IHTSDO

		 FORMCHECKBOX 
 WEDI



		 FORMCHECKBOX 
 CLSI

		 FORMCHECKBOX 
 ISO

		 FORMCHECKBOX 
 Other (specify below)





		Not applicable.  This work will not directly involve other SDOs at this time.





8. Realm


Click here to go to Appendix A for guidelines regarding choosing Universal or Realm Specific.


		 FORMCHECKBOX 


		Universal






		

		 FORMCHECKBOX 
    Realm Specific



		

		 FORMCHECKBOX 
    Check here if this standard balloted or was previously approved as realm specific standard





				



		

		





9. Strategic Initiative Reference – For PMO/TSC Use Only

Click here to go to Appendix A for more information regarding this section


		This section used only for Strategic Initiative Projects.

 FORMCHECKBOX 


1. HL7 Recognition

 FORMCHECKBOX 


2. HL7 Internal Processes

 FORMCHECKBOX 


3. HL7 Implementation







Appendix A - Instructions (Delete prior to submitting the completed scope statement)  


Click here to return to this section in the template above.

Project Scope Statement Purpose:

This Project Scope Statements is intended for products used outside HL7, such as projects to produce standards or Implementation Guides.  Infrastructure projects (the RIM, HL7 maintained vocabulary, wrappers, and methodology) should also use this scope statement but are not required to complete all sections as noted in the instructions.


The objective of this template is to communicate the type of activities a group is undertaking to achieve specific objectives or to produce specific work products.  Project Scopes should provide sufficient information to allow inexperienced individuals to anticipate what a group is working on and decide if they wish to become involved.  Project Scope statements should also assist committee chairs to manage the workload of the committee and help to set priorities and recognise inter-dependencies with the work of other committees.

The Steering Divisions, TSC, and other appropriate approval bodies, as defined by the HL7 organization and Project Approval and Initiation Process, review and approve the project request.  This includes analysis to avoid project overlaps or dependency gaps.  A project not aligned with HL7 strategies established by the HL7 Board, or requiring extensive resources may not be approved. A “hosted” project (funded by an external source) may be approved as long as the sponsors provide adequate resources and the project is not detrimental to HL7 strategy; funding may be in the form of resources or financial support, grants, etc.


Required Information:


The HL7 Project Management Office (PMO) will review project statements to ensure the names and descriptions are clear and unambiguous across all projects and that required information is provided so as to obtain project approval.  

Project Insight Note:


The following instructions indicate how the information in this form is mapped to certain fields in Project Insight’s project description form. The fields are mapped to specific fields in the project description form available in Project Insight: http://healthlevelseven.projectinsight.net/Login.aspx?ReturnUrl=%2fdefault.aspx

If you need system login setup for Project Insight, contact the HL7 Director of the Project Management Office at pmo@hl7.org

Recommendation for Non-infrastructure Projects:


The HL7 Product Lifecycle recommends ballots proceed through Informative ( DSTU ( Normative phases, however, HL7 policy allows projects to proceed to normative ballot without an Informative or Draft Standard for Trial Use (DSTU) in special circumstances, such as such the need to respond to government mandate or resolve a critical issue raised by a stakeholder or noted in an existing American National Standard.  Bypassing the Informative and/or DSTU ballot must be approved by the TSC.  Refer to the HL7 Governance and Operations Manual Section 13 – Review Ballot and Section 14 – Normative Ballot for additional information.

1. Project Name and ID  Click here to return to this section in the template above.

		The name should be concise, based on the objective and unique among all other projects the group takes on.  Project Insight: Enter into “Name”.

		Project ID: A project ID will be assigned by Project Insight 



		Product(s):  Indicate the associated Product line(s); check all that apply.  Refer to the “Products” tab of the worksheet at the following URL for the definition of the products: http://www.hl7.org/documentcenter/public/wg/sips/Products&ServicesRevenueMatrix.xls.  Additional information regarding HL7 Products is available at http://wiki.hl7.org/index.php?title=Product_List_FAQ.


Project Insight: Enter into “Product Type”.





2. Sponsoring Group(s) / Project Team Click here to return to this section in the template above.

		Primary Sponsor/Work Group (1 Mandatory): Some projects are jointly sponsored and the name of all sponsoring Work Groups should be noted.  Every project must have at least one project sponsor and a project facilitator; a multi-disciplinary project team is recommended, e.g. domain expert, UML modeling facilitator, HL7 modeling facilitator, requirements process facilitator, data analyst facilitator, business requirement analyst.  Sponsorship may be in the form of resources or funding.  Project Insight: Enter into “Sponsor(s)”.





		Project Facilitator (1 Mandatory): This is mandatory for all projects and should be the contact person if there are questions about the Project Scope Statement.  The Project Facilitator serves as the Project Lead; the 'go to' person for the project who can answer questions regarding status, scope, objectives, issues, risks, etc. regarding the project.  Project Insight: Enter into “Project Facilitator”.





		Other Interested Parties:  This section should also describe other ‘interested parties’, e.g. anticipated interactions with other committees or other projects.  






		Facilitators:  Modeling, Publishing, and Vocabulary facilitators are formal roles recognized by HL7, and highly recommended as project participants.  If your project has not filled this role, please indicate a contact person for the role, for example, your project may not have a formal vocabulary facilitator but a committee participate has volunteered to serve as liaison with the Vocabulary Committee.





		Infrastructure projects, for example, the RIM, HL7 maintained vocabulary, wrappers, and methodology are required to name only the Primary Sponsor and Project Facilitator.






		Implementers (2 Mandatory):  If this project will produce a standard, identify at least two implementers who agree to implement a DSTU prior to normative ballot (this is a non-binding agreement). Contact information is mandatory.  The intended implementers must be identified at project initiation; however, it is a non-binding agreement.  Refer to explanation of Candidate Standard validation below for additional information.  Project Insight: Enter into “Project Implementers”.







Candidate Standard validation

		Candidate Standard validation

		Executing the Candidate Standard validation approach. HL7 will have a modified open approach to candidate standard validation. All those participants that made a non-binding commitment when the project was initiated will be included if they choose to honor the commitment. Others may be added to achieve a balance or for other necessities for validation. The previous notwithstanding, HL7 will limit the number of participants to ensure a manageable process and reasonable time frame. 



		Candidate Standard validation approach

		A project step that ensures that the Candidate Standard is validated by external industry resources before it is finalized as a normative standard. Where the standard is for interoperability, it is expected that the validation will include at least two independent entities (vendors, user organizations, etc.) building trial implementations and testing them together. Where the standard serves another purpose the validation approach will involve a trial effort to use the draft standard in the manner for which it was created.


At the planning stage the entities willing to test must make a non-binding declaration of their intent to participate in validation. Without such a declaration the project should not be initiated. 


Comment: This is expected to be a significant hurdle for new project initiation. At the same time it helps to assure that HL7 member resources will be concentrated on efforts that have a greater likelihood at industry adoption.





3. Project Definition  Click here to return to this section in the template above. 

3.a. Project Scope

		The detail should be sufficient that an individual with no previous exposure to the group (or even HL7) could understand the expected activities and results.  The scope description should also include high level expectations for the project and indicate alignment with market demands or other drivers for the project, such as government mandates, requirements from industry interoperability connectathon, etc.  Also include if the project is abandoning or replacing anything.

Typically projects to produce standards are routinely supported by the volunteer resources committing to complete the project, and HL7 in the form of meeting rooms, conference call facilities, etc.  If additional funding is required, you must provide a budget for the project.   A proposed budget is required for any project that will be contracted, for example, website redesign or tooling development.

Project Insight: Enter into “Description”.





3.b. Project Need

		Explain the reason behind the need for this project.  This may be related to legislative requirements, industry needs or similar justifications.  


This section must be completed for projects containing items that are expected to be ANSI approved, as it is an ANSI requirement for all ballots.  The information will be used in the NIB form.  


Project Insight: Enter into “Project Need” 





3.c. Success Criteria

		Indicate the success criteria for the project.  


Project Insight: Enter into “Succss Criteria” 





3.d. Project Objectives / Deliverables / Target Dates


Click here to return to this section in the template above.

		Enter a list of objectives the project is trying to meet. If the project is to develop one or more work products, the work products’ descriptions should be clear, concise and unambiguous.  Work products intended to produce a standard should be in terms of the  deliverables:


· new elements methodology (e.g. a new way of deriving message specification from a in information model)


· new interface specification for services or application roles


· new functional models


· new message specification (e.g. a new message structure that refers a the state transitions of a new type of clinical act)


· new standard profiles (e.g. CDA implementation guide)


· new terminology subsets or mapping


· new tools intended to improve productivity and support the methodology


In those cases where the objectives are not work products, they should be described so that an outside observer can answer “yes” or “no” to the question “has this objective been met?”


As the project progresses, objectives and work products can be refined.


Projects that have more than one work product to deliver should list each work product’s expected delivery date, taking into consideration expected dependencies among work products.


Project Insight: Enter into “Pjt Objectives and Deliverables ”.

		Target Dates


Exact dates are not needed.  


Enter in WGM or ballot cycle format, e.g. : ‘2010 Sept WGM’ or 


‘2010 Jan Ballot’.


Target dates in Project Insight are only provided in the above format.


Target dates can be updated. 


 





Example of Objectives / Deliverables / Target Dates:

Click here to return to this section in the template above.

The following attempts to convey how to identify various objectives /deliverables and their target dates.


		Objective / Deliverable

		Target Date



		Complete analysis, design, draft specification work on Standard XYZ

		2009 Sept WGM



		Submit for Comment Only Ballot

		2010 Jan Ballot



		Consider Comments from the Comment Only Ballot

		2010 Jan WGM



		Submit for DSTU Ballot

		2010 May Ballot



		Consider Comments from the DSTU Ballot

		2010 May WGM



		Submit to TSC for DSTU approval

		2010 Sept WGM



		DSTU Period – 2 years

		Jan, 2011 – June, 2012



		Submit Implementation Guide for Informative Ballot

		2011 Jan Ballot



		Submit Standard XYZ for Normative Ballot

		2012 Sept Ballot



		Reconcile from Normative Ballot 

		2012 Sept WGM



		Submit for Normative Ballot v2

		2013 Jan Ballot



		ANSI Approves Standard XYZ

		2013 May WGM



		Close Project (project end date)

		2013 May WGM





3.e. Project Dependencies 


		This section is not required for Infrastructure Projects.


The dependency may be the work of another project undertaken by this group or by another group.  Anticipating dependencies can allow groups to coordinate their effort to ensure the overall objectives of HL7 can be met.  An example of a dependency is: The CDA ballot needed the Data Types produced by Infrastructure and Management Project to be through ballot before the CDA ballot could be finalised.


Project Insight: Enter into “Pjt Dependencies”. 





3.f. Project Document Repository Location.

		Indicate where can one go to find deliverables/documents created by the project team by entering the EXACT URL(s) where one can go to find deliverables, documents, artefacts created by the project team for this project.  The URL could point to  the HL7 Wiki, TSC Wiki, GForge, Project Insight, etc.  A template to create a Project Page on the HL7 Wiki is available at: http://wiki.hl7.org/index.php?title=Template:Project_Page

Project Insight: Enter into “Project Document Repository”.





3.g. Backward Compatibility.

		Indicate the backward compatibility of the expected project artefacts/deliverables, if known.


Project Insight: Enter into “Backward Compatibility”; enter additional information into ‘Misc. Notes’..





4. Products  Click here to return to this section in the template above.

		Product(s):  Indicate the associated Product line(s); check all that apply.  Additional information regarding HL7 Products is available at www.HL7.org > Standards > Introduction.  For additional information on creating or modifying HL7 processes, refer to the document Introducing New Processes to HL7 (balloting as Comment Only in the Jan 2012 cycle; will be published after that).

Project Insight: Enter into “Product Type”.





5. Project Intent  Click here to return to this section in the template above.

		Indicate if/how this project affects a standard or HL7 policy/procedure/process.  


If a project is withdrawing an informative document, additional information can be found in the GOM Section 13; information regarding withdrawal of an HL7 American National Standard can be found in GOM Section 15. If a project is adopting/endorsing an externally developed Implementation Guide, additional information can be found in the GOM Section 18.  The GOM is available at: http://www.hl7.org/documentcenter/public/membership/HL7_Governance_and_Operations_Manual.pdf).


Project Insight: Enter into “Project Intent”.





5.a. Ballot Type

		If applicable, indicate the type of balloting the deliverables will go through


Project Insight: Select a value from the “Type” dropdown.





6. Project Approval Dates  Click here to return to this section in the template above

		Note that the SD and TSC Approval dates don’t need to be captured in this template; this section simply reminds project facilitators about the need to gather SD and TSC approval.  SD/TSC approval dates will be entered into Project Insight as they occur.


Work Group Approval Date: The date the sponsor’s Work Group approved the project.   Project Insight: Enter into “Start Date”.

SD Approval Date: The date the sponsor’s Steering Division approved the project.  Project Insight: Enter into “SD Approval Date”.

The PBS Metrics Reviewed? checkbox is a reminder for the Steering Divisions to look at the Work Group’s PBS Metrics during their SD review process to insure that the Work Group has the bandwidth to take on additional project work.


TSC Approval Date: The date the Technical Steering Committee approved the project. Project Insight: Enter into “TSC Approval Date”.





7. External Project Collaboration   Click here to return to this section in the template above.

		Include SDOs or other external entities you are collaborating with, including government agencies.  Indicate the nature and status of the Memorandum of Understanding (MOU) if applicable.


Agreement Status: Memorandum of Understanding (MOU) or Associate Charter Status types are:  Negotiating or signed (please indicate the date signed.)  Leave blank if there is no agreement in place. Refer to http://www.hl7.org/about/agreements.cfm for a current listing of HL7’s MOU agreements.


Project Insight: Enter into “Collaboration Efforts”.





7.a. Stakeholders / Customers / Providers

		This section must be completed for projects containing items that are expected to be ANSI approved, as it is an ANSI requirement for all ballots.  The information will be used in the NIB form.  


Indicate the associated stakeholders, customers and providers for which this project is intended.  Check all that apply. 

Project Insight: Enter into “Stakeholders / Customers / Providers”; enter additional information into ‘Misc. Notes’.





7.b. Synchronization With Other SDOs / Profilers  Click here to return to this section in the template above.

		Indicate the existence, or absence, of related implementation guides or standards with the appropriate SDO/Profiler.  The list here includes those that HL7 has an agreement with as listed via www.HL7.org > About HL7 > Agreements.

The main goal of this section is to get to get clarity on potential conflicts with other SDO/Profiler deliverables that we can address at the time of project definition.  Also, we want to avoid confusion for stakeholders that have to deal not only with HL7 but also other SDO/Profiler deliverables.  An example of this is the development of implementation guides where we want to make sure that it is done jointly with, say, IHE, or that it is clearly stated in this section why the proposed IG is different from similar IGs.


Project Insight: Enter into “Synchronization With Other SDOs / Profilers”; enter additional information into ‘Misc. Notes’.





8. Realm Click here to return to this section in the template above.

		Indicate whether the project is applicable globally (universal), or intended for a specific country or region (realm).  Note that Non-US realm project scope statements should be directed to the appropriate HL7 Affiliate.

Projects meeting one or more of the following guidelines are candidates for being universal realm projects. 


· Stakeholders representing 2 Realms at a minimum, where stakeholder should be interpreted as a specific group or organization listed in the External Project Collaboration section or the Stakeholders / Vendors / Providers section of the project scope statement 

· Requirements coming from a minimum of 2 Realms 

· Project will be implemented in a minimum of 2 Realms 

· Minimum of 2 Realms represented on project team

Also note that if the Realm changes from ‘Realm Specfic’ to ‘Universal’ additional project resources may be necessary to support that change.  This is considered a ‘significant’ or ‘major’ change and should go through the project approval process as a Universal Realm project.


If applicable, check the box to indicate that the standard balloted or was previously approved as realm specific standard.

Project Insight:  Enter into “Realm” and “HL7 Affiliate” (if applicable).





9.  Strategic Initiative Reference Click here to return to this section in the template above.  

		This section is for Internal Use Only.  The HL7 PMO and/or the TSC will assist in determining if a project is a Strategic Initiative project, and if so, will identify which Strategic Initiative the project aligns with.  For more detail regarding the HL7 Strategic Initiatives, go to:  http://www.hl7.org/documentcomments/index.cfm   


Project Insight:  Enter into “Strategic Initiatives Reference”






Appendix B - Project Approval 

Click here to return to this section in the template above.  


		Every project scope statement must follow the appropriate review/approval process based on its project sponsor:  


· Work Group


· TSC


· Marketing or Board Committee


· Board of Directors or a Contract project


· International Council


· HL7 Affiliate


Documentation detailing these processes is located at:


www.HL7.org > Participate > Templates > Project Scope Statement and Project Approval Process or directly at the permalink http://www.hl7.org/participate/templates.cfm?ref=nav.





Appendix C – Frequently Asked Questions  


Click here to return to this section in the template above.

Q:  What is the definition of a project?


Answer: 

From the HL7 Development Framework, Section 2.2.1, HL7 Work Effort:


An HL7 work effort represents an activity being undertaken by an existing Work Group or Board appointed committee to achieve specific objectives or to produce specific work products. 


A Work Group shall consider a work effort to be a project if one or more of the following is true of that work effort: 


• involves a group outside of HL7 (may require Board approval) 


• requires external funding (may require Board approval) 


• is going to be balloted 


• requires cross-committee participation 


• is determined to be a project by the committee 


An HL7 project: 


• has an objective (statement of what is going to be produced), 


• will have a finite existence (the end date to be determined by the resources available and the start date), and 


• if additional funding is required, it will have a budget (including resources and funding sources) 


• will have at least one participant available to contribute and must have a project leader, if only an interim to get the project started 


• will have at least two implementers (unless the project is intended to support the HL7 infrastructure)


• will have an estimated schedule    


Project Management Institute’s PMBOK Guide and the publication “The Fast Forward MBA in Project Management” indicate the following:


Typically, a project is a temporary endeavor undertaken to create a unique product or service.  All projects have two essential characteristics.  (1) Every project has a beginning and an end. (2) Every project produces a unique product.  HL7 also recognizes ‘Maintenance’ projects which usually repeat on an annual basis; these maintenance projects do not need to be re-submitted or have a definite end date.

Temporary means that every project has a definite beginning and a definite end.  Temporary does not necessarily mean short in duration, it just means that projects are not ongoing efforts.  Furthermore, projects involve something that has not been done before and which is, therefore, unique.


Projects shouldn’t be confused with ongoing operations.  Ongoing operations have the opposite characteristics of projects in that they have no defined end and they produce similar, often identical, products.  Examples of ongoing operations are (a) an insurance company processes thousands of claims every day; (b) a bank teller serves over 100 customers daily, providing a few dozen specific services.


The objective of a project is to attain the objective and close the project.  The objective of an ongoing operation is typically to sustain the business.


Q: Do I need to create a Project Scope Statement if my project isn’t going through the ballot process?


A:  Yes, all projects need to have a Project Scope Statement completed and submitted to the HL7 PMO.  A lot of work done by Education, Marketing, Electronic Services, ArB, PIC, etc. does not need to go through the ballot process, however, visibility of that work is necessary.  Project Scope Statements are the foundation for communicating project information.  They also serve as a tool for Project Facilitators to gather the right information to begin a project as well as track the project’s progress.


Q:  Do I need to create separate Project Scope Statements for each Implementation Guide or other support documents?


A:  A single PSS can indicate multiple deliverables for the standard being addressed, so, no, a separate PSS does not need to be created for each Implementation Guide or support document for that standard.  Simply identify all of the Implementation Guides and documents in the Project Objectives and Deliverables section that are to be produced for the project.


Q: The scope or objective of my project changed.  Do I need to create a new PSS?

A:  You may or may not have to as it depends on the change. Oftentimes, the scope or objectives of a project may change during its lifecycle, perhaps due to regulatory changes or tying back to a different standard.  .  When the scope changes, it is preferred that a new Project Scope Statement NOT be created.  By keeping the same Project ID, the ballot site can readily point the same project ID to both DSTU and Normative ballots.   

If the change in scope or objectives is minor, simply update the existing project scope statement, and within Project Insight, indicate the modifications in the appropriate fields.  You can also use the ‘Misc. Notes’ text box for documentation.


However, if the change in scope or objectives is major, the Project Facilitator should submit a new Project Scope Statement, as many of the original information won’t accurately reflect what is being done anymore.


Q: What defines a ‘major’ or ‘significant’ change in scope?


A: Since ‘major’ and ‘significant’ are subjective terms, examples may provide better comprehension of a “major” or “significant” change to a project scope statement.  


A “major” or “significant change” in project scope is when the impact is that:


· Creating a new Release of a Standard


· The Project End date extends by 12+ months 

· Additional HL7 funds are required

· The Project Intent changes (i.e. the project changes from “Revising a Standard” to “Creating a Standard”)


· The change in scope will result in an item that qualifies as ‘substantive change’ as defined in GOM Section 14.08.04.


· The Ballot Type changes to a Normative  (i.e. the project changes from planning for an Informative ballot to a Normative ballot)


· The Realm changes from ‘Realm Specific’ to ‘Universal’ (since additional project resources may be necessary to support that change)

· The deliverable’s backwards compatibility changes from ‘Yes’ to ‘No’


Q:  Do I need to include budget figures in my scope?

A: Typically projects to produce standards are routinely supported by the volunteer resources committing to complete the project, and HL7 in the form of meeting rooms, conference call facilities, etc.  If additional funding is required from HL7, you must provide a budget for the project.   A proposed budget is required for any project that will be contracted, for example, website redesign.

Q: I’ve submitted my PSS to my Steering Division for approval but haven’t heard anything from them.  What should I do?

A: First, check the Steering Division’s meeting minutes.  Look to see if your project was on one of their agendas, and if so, if it was approved or the SD had further questions.  Your first point of contact with the SD should be their Project Facilitator.  If you can’t contact them, contact the Steering Division Representative and Alternate.


If the SD has approved your project, they will submit it to the TSC for approval via GForge’s tracker system.  To view which approvals your project has gathered, find your project by using the Searchable Project Database (http://www.hl7.org/special/Committees/projman/searchableProjectIndex.cfm), located on the www.HL7.org Homepage).  

Q:  Do I need to update the PSS if I discover after it’s approved that I need to coordinate ballots with other HL7 Work Groups?


A: Yes, we recommend updating the Ballot Strategy section of the Project Scope Statement as well as Project Insight.  Include the ballot name and release/version your project is coordinating with. 


Q:  When reaffirming a standard, does a PSS need to be created and go through the review/approval process?


A:  Yes.  Reaffirmation of a standard requires a normative ballot.

Q:  When withdrawing a published standard or a standard that has gone through balloting, does a PSS need to be created and go through the review/approval process?


A:  In most cases, a PSS is not required.  However a Notice of Withdrawal of Proposed ANS form must be completed and submitted to the TSC, following GOM Section 14.14.  This form can be found via www.HL7.org > Resources > Templates > Notice of Withdrawal of Proposed ANS.

In this case ‘withdrawing a standard’ refers to many things, such as choosing not to extend a standard that has reached its 5 year end-of-life or identifying the need to sunset a standard.  

A PSS does need to be created if the standard being withdrawn is intertwined/intermingled with other standards.  The PSS provides visibility so dependencies in other standards can be changed.

Q:  Should a Work Group create a new PSS when creating a new Release of a Standard?

A: Yes, in all cases, a new PSS should be created whenever work on a new Release of a Standard is being done.  Do not modify the PSS that refers to a prior Release.  In most all cases, there will be a significant enough change in the newer Release of the Standard to warrant a new PSS.  Also, a new PSS helps for tracking and historical purposes, as a new PSS assists HQ in keeping a one-to-one relationship of standards to projects.

Q:  How do I know the approval status of my project?

A: Look up your project using the Searchable Project Database (http://www.hl7.org/special/Committees/projman/searchableProjectIndex.cfm), located on the www.HL7.org Homepage).  The search results will reflect SD and TSC approval statuses either by reflecting the date the group approved the project or indicated ‘Awaiting Approval’ if the group has not approved the project.


Q:  What approvals are needed if I revise my existing PSS, say the project’s scope changes?  

A: The same approval process should be followed whether it’s a new project or a scope change to an existing project.


When the scope is changed in a project, the modified Project Scope Statement will be approved by the primary WG and the SD, providing the TSC using the same time line and deadlines as submissions for new projects.  When the scope changes, it is recommended that a new Project Scope Statement NOT be created.  By keeping the same Project ID, the ballot site can readily point the same project ID to both DSTU and Normative ballots.   


Best practice:  Use Microsoft Word’s ‘Track Changes’ tool to highlight the changes being made to the Project Scope Statement.


Q:  What ballot types are required to go through the project approval process?

A: All ballot types (Comment Only, Informative, Normative, DSTU) need to go through the project approval process, however, as identified in the Project Scope Statement, a single project can define ballot plans for multiple types of ballots for the project, for example, Comment Only >DSTU > Normative or Informative > Normative.


Q:  Do I need to go through the project approval process if a standard has expired and will not be reaffirmed?  

A: No. When a work group has balloted a standard at DSTU, informative, or normative ballot, and decides the standard will be withdrawn, the withdrawal form at www.HL7.org > Resources > Templates > Notice of Withdrawal of Proposed ANS Template is needed for ANSI notification and must be approved by the Work Group and then submitted to and approved by the TSC. 


Q:  What is the approval process for HL7 projects that collaborate with ISO or the JIC?

A: Follow the process documented on via www.HL7.org > Participate > Balloting > HL7's Collaboration with ISO and JIC .


Q:  Do I need additional approvals when creating or modifying an HL7 Policy/Procedure/Process?


A: Yes.  Work Groups should also have the Architectural Review Board review/approve the PSS.  Work Groups should include the ArB when sending the PSS to their Steering Division for review/approval.  For additional information on creating or modifying HL7 processes, refer to the document Introducing New Processes to HL7 (balloting as Comment Only in the Jan 2012 cycle; will be published after that).

Q:  How should a Work Group document the voting results after seeking approval for the PSS?

A: The ideal way is to post it in meeting minutes, so that they are documented and easily referenced.  If that’s not possible, an email to the Listserv will suffice.


Q:  Define ‘task’ and ‘activity’ as related to project management.

A:  Theoretically, ‘activity’ is the action verb within a ‘task’.  However, for HL7 projects, ‘task’ and ‘activity’ can be considered synonymous terms.  


Task/activities should be:


· Specific - a single, well defined, discrete activity.  The 8/80 is a good guideline -- no task should be smaller than 8 hours or larger than 80 hours.


· Achievable - it should be something that can be done as a single deliverable and can be defined as being completed or done such as a document being produced.


· Measurable - it should be an activity that can be measured such as a deliverable produced, an elapsed period of time or number of iterations


Q: How should a Work Group document annual work/maintenance within Project Insight?


A: A project entry should be opened in Project Insight indicating the annual work and the respective years.  This project should have a Project Status of ‘3 Year Plan Item’; note that a Project Scope Statement isn’t needed for this entry because it’s a 3 Year Plan item and only high level information is necessary.    This project can then remain ‘as-is’, or modified so it indicates accurate future years.


When the Work Group actually begins the annual work, they should complete a PSS indicating the scope of work involved and gather the necessary approvals for the PSS.  A new project in Project Insight will be created (and will have a Project Status of ‘Active Project’).  Once the scope of work has been completed for this project, it will be closed/archived.


Hence, the 3-Year Plan project always remains open; the ‘Active Project’ PSS will be the project reflecting the specific annual maintenance being done.


An example of the above situation can be found for Project Service’s annual updates to the PSS Template.  Project 531 is the 3YP entry indicating the need for the work in 2010, 2011, 2012, 2013 and beyond.  Project 581 was created to identify the specific work that would be done for the 2010 updated template.  In January, 2010, project 581 was closed because the new PSS template was released to membership, however project 531 was modified to remove references to ‘2010’ and remains open to indicate the need for the work each year.


Q: Should a project remain open/active during its DSTU Test Period?

A: Yes, it should.  This means that the project will continue to show up in the Searchable Project Database and on Project Insight reports.

Q: Why was I asked to Disable or Enable a macro when I opened this document?

A: This document contains a macro that, when run by the user, removes the green ‘help’ text within the template portion of this document and provides a cleaner version of their project scope statement.  To run the macro, select Tools > Macro > Macros… > Run.

Note that the macro will NOT remove the Appendices; the user must remove the Appendix verbiage on their own.


Q: How do I search/view HL7 Projects?


A: There are three ways to view HL7 projects, all located at www.HL7.org > Participate > Tools and Resources > Project Tracking Tools


(http://www.hl7.org/participate/toolsandresources.cfm):


1.
The Searchable Project Database (http://www.hl7.org/special/Committees/projman/searchableProjectIndex.cfm, located on the www.HL7.org Homepage and titled ‘Search current projects from Project Insight)


2.
An Excel spreadsheet of all HL7 projects is available via GForge > TSC File tab (http://gforge.hl7.org/gf/).


3.
Project Insight (a Project Insight User ID and Password is required – this differs from your HL7 User ID and Password).  Contact the HL7 PMO for more information (pmo@hl7.org).  The URL is: http://healthlevelseven.projectinsight.net/l.aspx?ReturnUrl=%2fdefault.aspx.


Q: Where can I find the Project Scope Statement Template?


A: The most recent version of the Project Scope Statement Template (MS Word document) is located at www.HL7.org > Participate > Templates (http://www.hl7.org/participate/templates.cfm).  


Q: Where can I find the list of Steering Division Leaders or Steering Division Project Facilitators?


A: Current Steering Division leaders can be found via their Steering Division webpage at http://www.hl7.org/Special/committees/index.cfm.  Current Steering Division Project Facilitators can be found via a PDF file at www.HL7.org > About > People and Organizations > HL7 Facilitators (http://www.hl7.org/About/hl7facilitators.cfm).

Q:  Do I need to specify a Reference Information Model (RIM) version in the V3 standard I am developing?


A: Unless specified, it is assumed that a project incorporates the current version of HL7 infrastructure (RIM, Datatypes and Vocabulary).


Project Services recommends that your Work Group’s modeling facilitator monitor proposed RIM changes that may impact the standards you are developing for the duration of your project.  The modeling facilitator can do this by subscribing to the harmonization@lists.hl7.org listerv.  For more information on RIM change proposals, contact the MnM Work Group.

Q:  What do I need to do if I want a project document to be publically available outside of HL7?

A: It’s a rare instance that a project will create and distribute a public document in accordance to the GOM’s ruling.  In the instance that a project deliverable does adhere to it, the project team will need to present a proposal to the Executive Committee to provide funding to create and distribute a document publicly.  GOM Sections 09.01(d) and 16.01 indicate that the Executive Committee determines what is publically available.  More information can be found at: http://www.hl7.org/documentcenter/public/membership/HL7_Governance_and_Operations_Manual.pdf.

Q:  Why can’t I turn Track Changes on within this document?


A: In order for the checkboxes to work smoothly, this document has been ‘protected’.  To use Track Changes, turn off the protection by clicking on: (pre- MS Word 2007) Tools > Unprotect Document or (MS Word 2007 and higher) Review > Protect Document.  Note that by unprotecting this document, when checking a Checkbox, a window will pop up and you’ll want to select the ‘Default Value’ radio button ‘Checked’. 
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